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หากจาํไมผดิ นี่นาจะเปนหนงัสอื Photoshop ที่อพัเดตมาไมตํ่ากวา 5 ครั้งของเรา 

เรยีกวาเปน 5th edition กไ็มผดิ เพราะทกุครั้งที่โปรแกรมมกีารอพัเดตครั้งใหญ เรากจ็ะ

อพัเดตหนงัสอืตามใหทนัสมยั ไมตกยคุ เพื่อใหผูอานรุนใหมๆ  ไดใชเครื่องมอืที่ถกูพฒันา

ขึ้น นาํมาใชทาํงานไดสะดวกจรงิๆ เปลี่ยนทนัตามเทคโนโลย ีและพฒันาฝมอืเพื่อไมให

เปนสองรองใครในยทุธจกัรของการใช Photoshop 

เชื่อเถอะครบัวา เครื่องมอืใหมๆ ของ Photoshop นั้น ยิ่งพฒันามากย็ิ่งลํ้าขึ้นมาก 

จากที่เคยตองใชเวลากวาชั่วโมงในการทํางาน หากรูจักอัพเดตตัวเองตามเครื่องมือของ

โปรแกรมใหทัน งานนั้นอาจจะเหลือเพียงไมกี่นาทีก็ได สวนเวลาที่เหลือ นําไปใชใน

กระบวนการคดิ การออกแบบ การตรวจทานผลงาน เทานี้กจ็ะถอืวาเปนผูใช Photoshop 

ที่ตอบโจทยกบัสงัคมเรงดวนในปจจบุนัไดอยางมคีณุภาพแลว

ขอใหสนกุกบัการเรยีนรูโปรแกรมครบั

ปยะบุตร สุทธิดารา

พฤษภาคม 2560

Editor’s 
Note
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Photoshop ไดอัพเกรดเวอรชันใหมเปน CC 2017 ทําใหโปรแกรมสําหรับตกแตง

ภาพอันดับหนึ่งที่ดีอยูแลว มีความสมบูรณแบบมากยิ่งขึ้น เพราะนอกจากจะพัฒนา

ฟงกชันการทํางานตางๆ ใหสมบูรณขึ้นแลว ยังปรับปรุงเครื่องมือบางตัวใหทันสมัย

ใชงานไดงายยิ่งขึ้นดวย 

สาํหรบัหนงัสอืเลมนี้ ผูอานจะไดรูจกักบั Photoshop CC 2017 อยางครบถวน และ

ยงัครอบคลมุเวอรชนั CS6 อกีดวย โดยจะไดเรยีนรูตั้งแตการเริ่มตนสมคัร Adobe ID ไป

จนถึงการใชงานเครื่องมือตางๆ เพื่อสรางสรรคงานอยางมืออาชีพ ไมวาจะเปนฟเจอร

ใหมอยางการตัดฉากหลังดวยคําสั่ง Select and Mask, ปรับปรุงภาพ Portrait ดวย

เครื่องมอืใหมของคาํสั่ง Liquify, ใชงาน Artboard เพื่อสรางสรรคงานที่หลากหลาย รวมถงึ

การประยกุตใชเครื่องมอือยางมอือาชพี และแนวทางการทาํงานอื่นๆ ที่นาํไปใชงานไดจรงิ 

พรอมทั้งวดิโีอ Workshop และภาพประกอบสาํหรบัทดลองทาํงานอกีดวย

สดุทายนี้ผูเขยีนหวงัเปนอยางยิ่งวา หนงัสอืเลมนี้จะชวยใหผูอานสามารถทาํความ

เขาใจและใชงาน Photoshop CC 2017 ไดอยางมปีระสทิธภิาพ หากมขีอบกพรองประการ

ใด ผูเขยีนตองขออภยัไว ณ ที่นี้ดวย

เกียรติพงษ บุญจิตร

พฤษภาคม 2560

Writer’s 
Note
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หากพูดถึงโปรแกรมที่ใชทํางานในสายตกแตงภาพ ออกแบบงาน

กราฟก โปรแกรมแรกที่สวนใหญจะนึกถึงคงเปน Adobe Photoshop 

ซึ่งปจจุบัน Adobe ไดพัฒนาและอัพเดตเวอรชันใหมเปน Photoshop 

CC 2017 ทีน่อกจากจะมฟีเจอรใหมๆ  ทีน่าสนใจ และชวยใหการทาํงาน

งายขึน้แลว Adobe ยงัปรบัเปลีย่นการซือ้ขายโปรแกรมจากการซือ้ขาด 

เปนเชาซื้อรายเดือน ที่สามารถอัพเดตฟเจอรใหมๆ ไดตลอดเวลา 

สําหรับเน้ือหาในบทนี้ เราจะมาเร่ิมตนทําความรูจัก และการลงทะเบียน

ติดตั้ง Photoshop CC 2017 กัน ซึ่งมีรายละเอียดดังนี้
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เริ่มต้นกับ Adobe Creative Cloud
ก่อนที่จะมาเป็น Adobe Creative Cloud ในปัจจบุนั เรารู้จกักบั Adobe ในนามของ Adobe Creative Suite หรอื 

Adobe CS ที่มกีารวางขายโปรแกรมแยกเป็นชดุตามรูปแบบการท�างาน เช่น งานด้านกราฟิก, เวบ็ดไีซน์ หรอืงานวดิโีอ 

ซึ่งการท�างานเหล่านี้จะต้องใช้โปรแกรมร่วมกนัหลายๆ โปรแกรม ท�าให้ผู้ใช้ต้องจ่ายเงนิค่อนข้างสูง เพื่อให้ได้โปรแกรม

ที่ครอบคลมุการท�างาน จงึเป็นปัญหาให้ Adobe Creative Suite ถูกละเมดิลขิสทิธิ์ค่อนข้างสูง ดงันั้น Adobe จึงปรบัปรงุ

รูปแบบการวางขายโปรแกรม แทนที่จะขายเป็นชดุเหมอืนที่ผ่านมา เป็นการเช่าซื้อในนามของ Adobe Creative Cloud  

หรอื Adobe CC ซึ่งท�าให้คณุสามารถที่จะใช้โปรแกรมของ Adobe ตรงความต้องการในราคาที่ถูกลง โดยที่โปรแกรมทกุ

ตวัในชดุของ Adobe Creative Cloud จะรอคณุอยูบ่นหน้า Cloud Service ให้คณุดาวน์โหลดโปรแกรมมาตดิตั้ง ซึ่งสามารถ

เลอืกบางโปรแกรม หรอืเลอืกจาก Plan การช�าระเงนิกไ็ด้

ข้อดีของ Adobe CC
จากรายละเอยีดที่กล่าวมาข้างต้นจะเหน็ว่า Adobe CC อาจดูยุ่งยากกว่า Adobe เวอร์ชนัที่ผ่านมา แต่มขี้อดทีี่น่า

สนใจดงันี้

โปรแกรมทีส่ามารถดาวน์โหลดได้จาก Adobe Creative Cloud 
ซึ่งเลือกเฉพาะโปรแกรมที่ต้องการได้ ไม่ต้องซื้อแบบเหมายกชุด
เหมือน Adobe Creative Suite 

• อพัเกรดโปรแกรมฟรตีลอดอายกุารใช้งาน โดยไม่

จ�าเป็นต้องลบ หรอืตดิตั้งโปรแกรมใหม่อกีต่อไป

• เมื่อมี Features ใหม่ หรือการแก้ไขโปรแกรม 

(Patch) กส็ามารถอพัเดตได้ตลอดเวลา

• มบีรกิารฟอนต์ฟรใีห้ดาวน์โหลดเกอืบ 700 ฟอนต์

• พื้นที่ฟรีส�าหรับเก็บไฟล์งานบน Cloud Storage 

สูงสุดถึง 100 GB ซึ่งช่วยให้สามารถเก็บงานที่

ส�าคญั และแชร์ไฟล์งานเพื่อท�างานร่วมกบัเพื่อน

ร่วมงานได้ทกุหนทกุแห่ง

• Admin Console เป็นส่วนที่ใช้จดัการสทิธิ์ผู้ใช้งาน 

ไฟล์ที่แชร์บน Cloud Storage ซึ่งเราสามารถ

ก�าหนดสิทธิ์ให้ผู ้ใช้แต่ละคนท�าอะไรกับไฟล์

ได้บ้าง เช่น เปิดดูได้อย่างเดียว, แก้ไขได้, 

เปลี่ยนแปลงและบนัทกึงานได้ เป็นต้น

• ทมีงาน Expert Support จาก Adobe และ Support 

จาก I.T. Solution Computer (Thailand) Co., Ltd. 

ที่จะอยู่เคียงข้างในการให้ค�าปรึกษาทั้งส่วนของ

การใช้งานโปรแกรม หรือในส่วนของการติดตั้ง

โปรแกรม
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เลือกประเภทของ Adobe CC ให้เหมาะกับการใช้งาน
การเลอืกประเภท หรอืเรยีกอกีแบบว่า Package ของ Adobe CC นั้นถอืว่าเป็นเรื่องส�าคญั เนื่องจากแต่ละ Package 

จะมบีรกิาร, ราคา รวมถงึส่วนลดที่แตกต่างกนัดงันี้

บุคคลทั่วไป (Individuals)
ส�าหรบั Package แบบบคุคลทั่วไป หรอื Individuals แบ่งเป็นประเภทย่อย 3 แบบดงันี้

• Photography เป็นชุดส�าหรับตากล้องโดยเฉพาะ จะมีโปรแกรม Photoshop และ Lightroom ซึ่งสามารถ 

ใช้งานบนคอมพวิเตอร์, อปุกรณ์พกพาอย่างมอืถอื Smartphone หรอื Tablet

• Single App จะสามารถดาวน์โหลดใช้งานได้ 1 โปรแกรมจากรายการที่ก�าหนด ได้แก่ Photoshop, Illustrator, 

InDesign, Acrobat Pro DC, Adobe Muse, Dreamweaver, Animate (Flash Pro), Adobe Premiere Pro, After 

Effects, Audition และ InCopy

• All Apps สามารถเลอืกใช้งานได้ทกุโปรแกรม

บริษัท หรือธุรกิจ (Business)
Package ส�าหรบับรษิทั หรอืธรุกจิ ซึ่งสามารถตดิต่อได้โดยตรงผ่านตวัแทนจ�าหน่าย

ตัวอย่าง Package แบบ Individuals ที่มี 3 ประเภทให้เลือก ซึ่งมีราคาที่แตกต่างกันดังภาพ

Package แบบ Business สามารถซื้อผ่านตัวแทนจ�าหน่าย และค้นหาตัวแทนได้โดยคลิกปุ่ม Find a Reseller
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นักเรียนและอาจารย์ (Students and Teachers) 
Package แบบ Students and Teachers ส�าหรบัการศกึษา จะม ี Package เช่นเดยีวกบัแบบบคุคลทั่วไป แต่จะมี

ส่วนลดที่ซื้อได้ถูกกว่า

โรงเรียนและมหาวิทยาลัย (Schools and Universities) 
Package แบบ Schools and Universities เป็นรูปแบบส�าหรบัเวริ์คกรุ๊ปขนาดเลก็, ห้องเรยีนและห้องปฏบิตักิาร หรอื

แม้กระทั่งสถาบนัการศกึษาทั้งหมด ซึ่งจะต้องตดิต่อซื้อผ่านตวัแทนจ�าหน่าย

Package แบบ Students 
and Teachers ที่มีรูปแบบเช่น

เดียวกับแบบ Individuals ซึ่ง
สามารถซื้อได้ในราคาที่ถูกกว่า 

แต่การสมัครจะต้องใช้เอกสาร
ในการยืนยัน เช่น บัตรนักเรียน 

หรือทรานสคริปต์ เป็นต้น

Package แบบ Schools and 
Universities สามารถซ้ือผ่าน

ตัวแทนจ�าหน่าย และค้นหา
ตัวแทนได้โดยคลิกปุ่ม 

Find a Reseller

ขั้นตอนการลงทะเบียนและติดตั้ง Photoshop CC 2017
การตดิตั้ง Photoshop CC 2017 (ต่อไปนี้ผู้เขยีนจะขอเรยีกสั้นๆ ว่า Photoshop CC) จะแบ่งขั้นตอนออกเป็น 2 ส่วน

หลกัๆ ด้วยกนัคอื การลงทะเบยีนขอ Adobe ID หลงัจากนั้นจะเป็นการเลอืก Package ที่ต้องการ แล้วช�าระเงนิพร้อม

ตดิตั้งโปรแกรม ซึ่งมขีั้นตอนโดยละเอยีดดงันี้

ลงทะเบียน Adobe ID
การลงทะเบยีน Adobe ID เป็น

ขั้นตอนแรกที่เราต้องจดัการ โดยมี

ขั้นตอนดงันี้

เปิดเวบ็ไซต์ www.adobe.com ขึ้นมา1 คลกิที่ 
Sign in

2
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เลือก Package ของ Photoshop CC
การเลอืก Package ของ Photoshop สามารถเลอืกได้ 2 

แบบคอื Single App ซึ่งจะต้องช�าระเงนิประมาณ 600 บาท

ต่อเดอืน และการเลอืก Package แบบ Photography ซึ่งจะ

สามารถดาวน์โหลดได้ 2 โปรแกรมคอื Photoshop CC และ 

Lightroom CC ซึ่งจะต้องช�าระเงนิประมาณ 300 บาทต่อเดอืน 

ซึ่งถูกกว่าแบบ Single App

หากพูดถึงความคุ้มค่าแล้ว การเลือก Package แบบ 

Photography จะคุ้มค่ามากกว่าในแง่ของการใช้งานทั่วไป 

แต่หากเป็นการใช้งานแบบกลุ่มที่ต้องการแชร์ไฟล์ร่วมกับ 

ผู้ใช้งานอื่นๆ รวมถงึใช้งานฟีเจอร์อื่นๆ ของ Creative Cloud 

ให้ได้ครบถ้วนนั้น Single App จะตอบโจทย์ได้ดกีว่า (การ

ติดตั้ง Photoshop CC ในหนังสือเล่มนี้จะเลือก Package 

แบบ Photography) ซึ่งขั้นตอนการเลอืก Package และตดิตั้ง  

Photoshop CC ท�าได้ดงัขั้นตอนต่อไปนี้

คลกิปุม่ Choose a plan เพื่อ
เลอืก Package การตดิตั้ง

1

กรอกอีเมลและพาสเวิร์ด
ของ Adobe ID ที่มอียู่แล้ว 
หรอืคลกิที่ Get an Adobe 
ID เพื่อสร้าง Adobe ID ใหม่

3

ระบอุเีมลและพาสเวร์ิด รวมถงึ
รายละเอยีดของผู้ใช้

4

คลกิเลอืกทั้ง 2 ตัวเลอืก 
แล้วคลกิป่มุ SIGN UP

5

เมื่อสมัคร Adobe ID เรียบร้อย
จะปรากฏรายละเอียดของ

Account ที่หน้าเว็บหลักทันที

6
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ช�าระเงินและติดตั้ง
หลงัจากที่เลอืก Package และ Plan การช�าระเงนิเรยีบร้อยแล้ว ขั้นตอนต่อไปเป็นการช�าระเงนิ โดยจะเป็นการกรอก

รายละเอยีดของบตัรเครดติ หรอืบตัร ATM แบบเดบติ เพื่อให้ Adobe หกัค่าบรกิารรายเดอืนตาม Plan ที่เลอืกไว้ ซึ่ง 

ขั้นตอนการช�าระเงนิท�าได้ดงัขั้นตอนต่อไปนี้

ในกรณีที่ต้องการติดตั้งด้วย Package แบบ Single App สามารถท�าได้โดยเลือกโปรแกรม

ที่ต้องการ และเลือก Plan การช�าระเงิน แล้วจึงคลิกปุ่ม BUY NOW

ส�าหรบั Plan การช�าระเงนิจะมอียู่ 3 แบบดงันี้

• Annual plan, paid monthly เป็นสญัญา 1 ปี 

ช�าระเงนิรายเดอืน

• Annual plan, prepaid เป็นสญัญา 1 ปี ช�าระ

เงนิล่วงหน้า

• Monthly plan เป็นสัญญา 1 เดือน (เฉพาะ 

Package แบบ Single App และ All Apps)

ส�าหรบั Plan ทั้ง 3 แบบนี้ เมื่อครบก�าหนดเวลา

แล้วจะเป็นการต่อสญัญาอตัโนมตั ิผู้ใช้ต้องแจ้งกบั

ทาง Customer Support หากต้องการยกเลกิสญัญา

NOTE

คลิกปุ่ม BUY NOW 
เพื่อเข้าสู่ขั้นตอนการ
ช�าระเงนิ

3

หลงัจากที่คลกิป่มุ BUY NOW แล้ว
จะปรากฏรายละเอียดสัญญาของ 
Package และ Plan ที่เราเลอืก โดย
มรีายละเอยีดที่ส�าคญัคอื จะมกีาร
เรียกช�าระเงินเป็นรายเดือน หรือ
รายปีตาม Plan ที่เลือก และจะมี
การต่ออายุสัญญาอัตโนมัติ โดย
จะส่งอีเมลแจ้งทุกครั้ง หากมีการ
ยกเลิกสัญญาก่อน 14 วัน จะคืน
เงนิเตม็จ�านวน หากยกเลกิสญัญา
หลงั 14 วนั จะคนืเงนิให้ครึ่งหนึ่ง 

1

หลงัจากที่อ่านรายละเอยีดสญัญาเรยีบร้อย ให้คลกิเลอืกตวัเลอืกดงัภาพ
แล้วคลกิป่มุ Accept Terms & Conditions เพื่อเข้าสู่ขั้นตอนการช�าระเงนิ

2

เลือก Package Photography พร้อมกับ
เลือกรูปแบบการช�าระเงินแบบ Annual 
plan, paid monthly

2
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ข้อความชี้แจงให้ทราบว่า Plan ที่เลอืก
จะถกูเรยีกเกบ็เงนิเท่าใด รวมถงึอาจมี
การเกบ็เงนิเพิ่มเตมิจากค่าธรรมเนยีม
ของบตัรเครดติ หรอืค่าธรรมเนยีมการ
แปลงสกลุเงนิ

3

หลังจากที่เข้าใจข้อตกลงและเงื่อนไขแล้ว ให้กรอกรายละเอียดของ
บตัรเครดติ หรอืบตัรเดบติลงไป

4

หากไม่ต้องการเปลี่ยนแปลงข้อมลู
ให้คลกิป่มุ Confirm Membership 
เพื่อยนืยนัการช�าระเงนิ

7

กรอกที่อยู่ในการจัดส่งใบแจ้งหนี้ 
แล้วคลกิป่มุ Continue

5
รายละเอยีดของ Package และ Plan ที่เลอืก 
รวมถึงข้อมูลบัตรเครดิต ซึ่งสามารถคลิกที่ 
Change เพื่อเปลี่ยนแปลงได้

6

หากยงัไม่ได้ตดิตั้ง Creative Cloud ไว้ จะปรากฏ
หน้าต่างให้บนัทกึไฟล์ส�าหรบัตดิตั้งทนัที

8

หลังจากดาวน์โหลดไฟล์เรียบร้อยแล้ว ให้
ดบัเบลิคลกิไฟล์เพื่อตดิตั้ง Creative Cloud

9
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คลกิแทบ็ APPS เพื่อ
แสดงรายการของ
โปรแกรมต่างๆ

11

ปรากฏปุ่ม Install ที่ 
โปรแกรม Photoshop  
CC (2017 )  และ 
Lightroom CC (2015) 
ซึ่งสามารถคลิกเพื่อ
ติดตั้งโปรแกรมได้
ทนัที

12

ส�าหรับโปรแกรมอ่ืนๆ ที่อยู่ 
นอกเหนือจาก Package ที่
เลือกไว้ เราสามารถคลิกปุ่ม 
Try เพื่อดาวน์โหลดโปรแกรม
มาทดลองใช้งาน ซึ่งจะใช้ ได้ 
30 วัน

หลังจากที่ติดตั้ง Creat ive 
Cloud เรยีบร้อยแล้ว ให้กรอก
อเีมลและพาสเวร์ิดของ Adobe  
ID ที่สมัครไว้ลงไป แล้วคลิก
ป่มุ SIGN IN

10

Adobe ID ติดตั้งได้กี่เครื่อง ?
หลังจากที่ขอ Adobe ID แล้ว 

จะสามารถดาวน์โหลดติดตั้ง 

กี่เครื่องกไ็ด้ จะเป็น Mac OS X 

หรอื Microsoft Windows แต่จะ

ต้อง Sign Out Adobe ID จาก

เครื่องที่เปิดใช้งานก่อน จึงจะ

สามารถตดิตั้งลงเครื่องอื่นด้วย 

Adobe ID เดมิได้ อย่างไรกต็าม 

ในการใช้งานนั้นจะสามารถ

ใช้ได้พร้อมกนัเพยีงแค่ 2 เครื่อง

เท่านั้น

NOTE

เมื่อการดาวน์โหลดเสรจ็สิ้น กส็ามารถท�างานใน 
Photoshop CC 2017 ได้ทนัที

14

คลิกปุ่ม Install เพื่อติดตั้ง  
Extenstion Manager CC, 
Extendscript Toolkit CC และ 
Touch App Plugins เพื่อให้
โปรแกรมท�างานครบถ้วน 

ทุกฟังก์ชันการใช้งาน

13
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มีอะไรใหม่ใน Photoshop CC 2017 บ้าง ?
หลงัจากที่ Photoshop CC ได้ปรบัปรงุเวอร์ชนัเป็น CC 2015 ตามมาด้วย CC 2017 ได้มกีารพฒันาเครื่องมอืเก่าให้

ท�างานได้มีประสิทธิภาพสูงขึ้น รวมถึงเพิ่มเติมฟีเจอร์ใหม่เข้าไป ช่วยให้การท�างานที่เคยซับซ้อนส�าเร็จได้ในขั้นตอนที่ 

น้อยลง แถมยงัได้ผลลพัธ์ที่สมบูรณ์แบบอกีด้วย โดยฟีเจอร์เด่นของ Photoshop CC 2017 มดีงันี้

Blur Gallery ที่สมบูรณ์แบบขึ้น
หลงัจาก Photoshop CC เพิ่มฟิลเตอร์ในกลุ่ม Blur Gallery ให้หลากหลายขึ้น และในเวอร์ชนั CC 2015 เป็นต้นมา 

Photoshop ได้ปรบัปรงุ Blur Gallery ให้สมบูรณ์ขึ้นไปอกีขั้นโดยการเพิ่มฟีเจอร์ Noise เข้าไป ซึ่งช่วยให้พื้นที่ที่ถูกเบลอ

มรีายละเอยีดสมจรงิกว่าในเวอร์ชนัเก่า

เพิ่ม-ลดความฝ้าให้ภาพด้วย Dehaze
Dehaze เป็นค�าสั่งที่เพิ่มเข้าไปให้ใช้งานใน Lightroom CC เป็นครั้งแรก และถูกน�ามาใส่ใน Photoshop CC 2015 

เป็นครั้งแรก ซึ่งค�าสั่งนี้จะใช้งานใน Camera Raw เพื่อจดัการกบัไฟล์ภาพ RAW จากกล้องดจิติอล โดยมหีน้าที่หลกัคอื

ลดความฝ้าจากฝุ่น หรอืหมอกที่ท�าให้ภาพมสีสีนัไม่สดใส ในทางตรงข้ามกส็ามารถใช้ค�าสั่งนี้เพิ่มหมอกให้ฟุ้งเข้าไปใน

ภาพได้เช่นกนั

ตัวอย่างการใช้ค�าสั่งในกลุ่ม Blur Gallery 
ปรบัแต่งภาพ ซึง่สามารถเพ่ิมค่า Noise ให้
กับพ้ืนท่ีท่ีถูกเบลอ ท�าให้ได้ผลลัพธ์ทีด่เูป็น
ธรรมชาติมากกว่าในเวอร์ชันเก่า

ตัวอย่างการใช้ค�าส่ัง Dehaze ใน Camera 
Raw ซึง่จะเหน็ว่าสามารถแก้ไขภาพทีม่ฝ้ีา
จากหมอกที่ท�าให้สีสันจืดชืด เป็นภาพที่มี
สีสัน และรายละเอียดที่สมบูรณ์ขึ้น
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ก็อปปี้ หรือย้ายรูปทรงแบบใหม่กับ Content-Aware Move
ใน Photoshop เวอร์ชนัเก่า เราได้รูจ้กักบัค�าสั่ง Content-Aware ที่ใช้ท�างานลกัษณะต่างๆ และในเวอร์ชนั 2015 เป็นต้น

มา Photoshop ได้เพิ่มเครื่องมอื  (Content-Aware Move Tool) ที่ใช้กอ็ปปี้ หรอืย้ายรูปทรงไปยงัจดุใหม่ พร้อมกบั 

ปรบัแต่งขนาดของรูปทรงได้ในเวลาเดยีวกนั

ใช้งาน Image Adjustments แบบ Smart Filters
Image Adjustments เป็นชดุค�าสั่งที่ใช้ปรบัแต่งแสงและสใีห้กบัภาพ เช่น ค�าสั่ง Levels, Curves, Hue/Saturation เป็นต้น 

โดยปกตมิกัถูกใช้งานผ่านพาเนล Adjustments เนื่องจากเป็นวธิปีรบัแต่งแบบ Nondestructive Layer คอื ค�าสั่งจะไม่

เปลี่ยนแปลงภาพโดยตรง ท�าให้ไม่เกดิความเสยีหายหากท�างานผดิพลาด แต่ Photoshop เวอร์ชนั CC 2015 เป็นต้นมา 

ได้ปรับปรุงการใช้ค�าสั่งในกลุ่ม 

Image Adjustments ให้เป็น

แบบ Smart Filters ที่นอกจาก

จะลดความซับซ้อนของเลเยอร์

ภาพแล้ว ยังสามารถใช้ค�าสั่ง  

Shadows/High l ights และ 

HDR Toning กบัภาพได้โดยไม่

ต้องกังวลว่าภาพจะถูกท�าให ้

เสยีหายหากปรบัค่าไม่เหมาะสม  

(ทั้ง 2 ค�าสั่งนี้ไม่เคยถูกเพิ่ม

เข้าไปบนพาเนล Adjustments 

เลย)

จุดเด่นอีกอย่างของเครื่องมือนี้คือ ถ้าเป็นการ

ย้ายวัตถุไปยังจุดใหม่ ค�าสั่งจะจัดการลบวัตถุที่อยู่

ในต�าแหน่งเดมิออกให้ด้วย

ตัวอย่างการใช้ค�าสัง่ Shadows/Highlights ปรบัแต่งภาพแบบ Smart Filters ซึง่ค�าส่ังจะถูกสร้างเป็น
ฟิลเตอร์แทนที่จะเข้าไปเปลี่ยนแปลงภาพโดยตรงเหมือนในเวอร์ชันที่ผ่านมา

ตัวอย่างการใช้เครือ่งมอื  (Content-Aware Move Tool) 
ย้ายภาพผู้ชายไปที่จุดใหม่ โดยสามารถปรับปรุงขนาดใหม่ได้ 
และค�าสั่งจะจัดการลบภาพจากจุดเดิมออกให้ด้วย



11

รู้จักกับ Photoshop CC 2017 01
CHAPTER

Crop ภาพพร้อมเติมเต็มส่วนที่ขาดหายด้วย Content-Aware
Content-Aware เป็นฟีเจอร์ที่เพิ่มเข้าไปให้กบัเครื่องมอื  (Crop Tool) ที่ช่วยเตมิพื้นที่ส่วนที่ขาดหายไปในกรณี

ที่เราครอปภาพพาโนรามาที่ต่อจากค�าสั่ง Photomerge หรอืการแก้ไขภาพเอยีงให้ตรงขึ้น ซึ่งอาจท�าให้บรเิวณขอบและ

มมุของภาพมพีื้นที่ว่างเกดิขึ้น

ตัดภาพที่ขอบไม่ชัดเจนง่ายขึ้นด้วย Select and Mask
Select and Mask เป็นค�าสั่งที่ปรับปรงุจาก Refine Edge ในเวอร์ชนัเก่า ซึ่งค�าสั่ง Select and Mask นี้สามารถสร้าง 

Selection ให้ภาพที่มขีอบเขตไม่ชดัเจนอย่างเส้นผมได้ดขีึ้น โดยมกีารเพิ่มเครื่องมอื  (Refine Edge Brush Tool) และ 

 (Refine Brush Tool) เข้าไป ท�าให้การค้นหาเส้นขอบของภาพท�าได้สมบูรณ์ยิ่งขึ้น

ตัวอย่างการครอปภาพด้วยเครื่องมือ  
 (Crop Tool) พร้อมกับเลือก 

Content-Aware ซึ่งจะช่วยเติมพ้ืนที่
ส่วนที่ขาดหายไปให้ทันที (ภาพขวา)

ตัวอย่างการใช้ค�าสั่ง Select and Mask ตัดฉากหลังออกจากภาพ ซึ่งท�าได้ดีแม้ว่าภาพจะมีขอบเขตไม่ชัดเจนนักก็ตาม
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ปรับรูปทรงใบหน้ากับ Face Aware
Face Aware เป็นฟีเจอร์ใหม่ของค�าสั่ง Liquify ซึ่งฟีเจอร์นี้ถูกเพิ่มเข้ามาใน Photoshop CC 2017 (ก่อนหน้านี้มใีห้

ใช้ใน Photoshop Mobile อยู่แล้ว) ความโดดเด่นของ Face Aware คอื สามารถปรบัรูปทรงใบหน้าให้เรยีวกระชับ ปรบั

ดวงตาให้โตขึ้น ปรบัจมูกให้เลก็ลง ปรบัรมิฝีปากให้อวบอิ่ม และเพิ่มรอยยิ้มได้ด้วย

ใส่ Style ซ้อน Style
การใส่ Style ให้เลเยอร์ใน Photoshop เวอร์ชนัเก่านั้น เราสามารถใส่ Style ประเภทเดยีวกนัได้ 1 ครั้งเท่านั้น เช่น 

เราไม่สามารถใส่ Stroke สร้างเส้นขอบให้วตัถซุ้อนกนั 2 ชั้นได้ แต่ใน Photoshop เวอร์ชนั CC 2015 เป็นต้นมา เรา

สามารถใส่ Style ประเภทเดยีวกนับนวตัถไุด้หลายๆ ครั้ง 

ตัวอย่างการใส่ Style ให้กับข้อความ ซึ่งจะเห็นว่าสามารถใส่ 
Style แบบ Stroke สร้างเส้นขอบให้ข้อความได้ถึง 2 ชั้น ซึ่งไม่
สามารถท�าได้ใน Photoshop เวอร์ชันเก่า

ตัวอย่างการปรับรูปทรงใบหน้าด้วยฟีเจอร์ Face 
Aware ในค�าสั่ง Liquify ซ่ึงสามารถปรับใบหน้าให้
เรียวขึ้น และปรับรูปทรงริมฝีปากเพิ่มรอยยิ้มได้ด้วย



13

รู้จักกับ Photoshop CC 2017 01
CHAPTER

ออกแบบงานได้หลากหลายขึ้นกับ Artboard แบบใหม่
ตั้งแต่ Photoshop เวอร์ชนั 2015 เป็นต้นมาได้เพิ่มเครื่องมอืใหม่ ได้แก่  (Artboard Tool) ซึ่งใช้ส�าหรบัสร้าง 

Artboard หรือพื้นที่การท�างาน ท�าให้ไฟล์งาน 1 ไฟล์ สามารถแยกเป็นหลายพื้นที่ส�าหรับการออกแบบที่แตกต่างกัน 

หลงัจากที่ท�างานเรยีบร้อย สามารถ Export ภาพแต่ละ Artboard ไปเป็นไฟล์ภาพ PNG, JPEG ได้ทนัท ี(การสร้าง Artboard 

จะเหมาะกบัการจดัเลย์เอาต์ภาพและข้อความ เพื่อใช้กบังานส�าหรบัเวบ็มากกว่าการรทีชัตกแต่งภาพ)

เก็บงานที่ใช้บ่อยเป็น Libraries
ใน Photoshop เวอร์ชนั CC 2015 เป็นต้นมาได้เพิ่ม Libraries เข้ามาส�าหรบัเกบ็ชิ้นงาน, Style, ส ีหรอืฟอนต์ที่ใช้งาน 

บ่อยๆ ท�าให้เราไม่จ�าเป็นต้องสร้างใหม่ทกุครั้งที่จะใช้งาน โดยวตัถแุละชิ้นงานที่สร้างไว้ใน Libraries นั้นจะเชื่อมต่อและ

เกบ็ไว้บน Creative Cloud ด้วย 

นอกจากนี้ Photoshop 

CC 2017 ได้เพิ่มการค้นหา

ภาพจาก Adobe Stock 

เข ้าไปด ้วย ซึ่งช ่วยให ้

สามารถค้นหา และซื้อภาพ

จากเว็บไซต์มาใช้งานได้

เบด็เสรจ็ใน Photoshop เลย

ตัวอย่างการสร้าง Artboard 
เ พ่ือออกแบบงาน ซึ่ งบน
พาเนล Layers จะปรากฏชื่อ
ของแต่ละ Artboard ซึ่งเรา
สามารถ Export ภาพเหล่านี้
ไปเป็นไฟล์ภาพได้ทันที

ตัวอย่างของภาพที่ถูกสร้าง
เก็บไว้ ในพาเนล Libraries 
(ภาพซ้าย) และการค้นหาภาพ
จาก Adobe Stock มาใช้งาน 
(ภาพขวา)
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In-App Search
ใน Photoshop CC 2017 ได้เพิ่มฟีเจอร์ที่เรยีกว่า In-App 

Search เข้าไป ซึ่งช่วยอ�านวยความสะดวกในการค้นหา

เครื่องมอื, บทเรยีนจากเวบ็ไซต์ หรอืภาพจาก Adode Stock 

มาใช้งาน เพยีงแค่กรอกคย์ีเวร์ิดที่ต้องการเท่านั้น สามารถ

เรยีกใช้งานได้โดยกดป่มุ +

ความต้องการของระบบส�าหรับติดตั้ง Photoshop CC 2017 
Photoshop CC 2017 เป็นโปรแกรมที่ต้องการทรพัยากรเครื่องค่อนข้างสูง ก่อนจะตดิตั้งควรตรวจสอบเสยีก่อนว่า 

เครื่องของเรามทีรพัยาการเพยีงพอหรอืไม่

Windows
• CPU : Intel® Pentium® 4 หรอื AMD Athlon 64 Processor (2 GHz หรอืสูงกว่า)

• ระบบปฏบิตักิาร : Windows 7 Service Pack 1, Windows 8 หรอื 10

• แรมอย่างต�่า 2 GB (แนะน�าที่ 8 GB)

• พื้นที่บนฮาร์ดดสิก์ส�าหรบัตดิตั้งอย่างต�่า 2.6 GB ส�าหรบัการตดิตั้งแบบ 32 บติ หรอื 3.1 GB ส�าหรบัการตดิตั้ง

แบบ 64 บติ และควรมพีื้นที่ว่างเหลอืขณะตดิตั้ง (ไม่สามารถตดิตั้งได้บนระบบปฏบิตักิารที่ใช้ระบบไฟล์แบบ 

Case-sensitive)

• จอภาพความละเอยีดอยา่งต�่า 1024x768 พกิเซล (แนะน�าที่ 1280x800 พกิเซล) หนว่ยความจ�า 512 MB (แนะน�า

ที่ 2 GB) การ์ดจอควรสนบัสนนุระบบ OpenGL 2.0 เพื่อความสมบูรณ์ในการใช้งาน

Mac OS
• CPU : Multicore Intel Processor

• ระบบปฏบิตักิาร : Mac OS X V10.9 (64 บติ) หรอื V10.10 (64 บติ) หรอื V10.11 (64 บติ)

• แรมอย่างต�่า 2 GB (แนะน�าที่ 8 GB)

• พื้นที่บนฮาร์ดดิสก์ส�าหรับติดตั้งอย่างต�่า 4 GB และควรมีพื้นที่ว่างเหลือขณะติดตั้ง (ไม่สามารถติดตั้งได้บน

ระบบปฏบิตักิารที่ใช้ระบบไฟล์แบบ Case-sensitive)

• จอภาพความละเอยีดอยา่งต�่า 1024x768 พกิเซล (แนะน�าที่ 1280x800 พกิเซล) หนว่ยความจ�า 512 MB (แนะน�า

ที่ 2 GB) การ์ดจอควรสนบัสนนุระบบ OpenGL 2.0 เพื่อความสมบูรณ์ในการใช้งาน

การตดิตั้งของทั้ง 2 ระบบปฏบิัตกิาร จะต้องเชื่อมต่ออนิเทอร์เนต็ส�าหรบัการลงทะเบยีนและตดิตั้งโปรแกรม 

ตัวอย่างการกรอกคีย์เวิร์ดค�าว่า Pen ลงไป 
ก็จะปรากฏสิ่งที่ต้องการขึ้นมาทันที



เริ่มตนกับ
Photoshop 
CC 201702

CHAPTER

หลังจากที่ติดตั้ง Photoshop CC 2017 แลวเปดขึ้นมาใชงาน

ครั้งแรก เราจะพบความเปลี่ยนแปลงอยางชัดเจนตั้งแต Interface ที่

เปลี่ยนไป ซึ่งในเวอรชันนี้ Photoshop ไดเพิ่ม Workspace แบบใหม

รวมถึงเครื่องไมเครื่องมือก็ถูกปรับเปลี่ยนตําแหนงใหม ใหเครื่องมือ

ที่ถูกใชงานบอยเรียกใชไดสะดวกขึ้น สําหรับผูอานที่เริ่มตนใชงาน 

Photoshop เปนครั้งแรก ก็ควรทําความรูจักกับองคประกอบหนาจอ

ของโปรแกรมใหดี เพื่อความสะดวกในการทํางาน ซึ่งจะมีอะไรบางนั้น 

สามารถศึกษาไดจากหัวขอตอไปนี้
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หน้าตาของ Photoshop CC 2017
ดงัที่กล่าวไว้ตอนต้นว่า Photoshop CC 2017 มกีารปรบัเปลี่ยน Interface จากเวอร์ชนัก่อนหน้า ถอืว่าเป็นการปรบั

เปลี่ยนครั้งใหญ่พอสมควร เมื่อเราเปดิโปรแกรมขึ้นมาครั้งแรกจะเจอกบั Workspace แบบใหม่ที่เรยีกว่า Start ที่จะแสดง

ไฟล์ภาพที่เราเคยใช้งานล่าสดุ 10 ไฟล์ และดา้นล่างของหน้าจอโปรแกรมจะแสดง News, Showcase และ Tutorial ต่างๆ 

เพื่อน�าเสนอข่าวและข้อมูลเสรมิส�าหรบัผู้ใช้งาน ซึ่งส่วนประกอบส�าคญัของ Workspace แบบ Start มดีังนี้

ไฟล์ล่าสุด 10 ไฟล์ทีเ่ปิดใช้งานเปลี่ยนรูปแบบการแสดงไฟล์ล่าสุดที่เปิดใช้งาน

สร้างไฟล์ใหม่ หรือเปิดไฟล์อื่นๆ  ขึ้นมาท�างาน ข้อมูลเสรมิอืน่ๆ จาก Adobe ซึง่จะอพัเดตอย่างสม�า่เสมอ

เลือกประเภทการแสดงบนหน้าจอ

ถงึแม้ว่า Workspace แบบ Start จะอ�านวยความสะดวกในการเข้าถงึไฟล์งานเก่าๆ ได้เรว็ขึ้น แต่ในบางครั้งอาจสร้าง

ความยุง่ยากขณะท�างาน หากผู้อ่านเคยชนิกบั Workspace แบบเดมิ ซึ่งเราสามารถปิดออปชนัการแสดง Workspace แบบ 

Start ได้โดยคลกิเมนู Edit > Perferences > General หลงัจากนั้นคลกิเครื่องหมายถูกหน้า Show “Start” Workspace 
When No Documents Are Open ออก เมื่อปิดแล้วเปิด Photoshop ขึ้นมาอกีครั้งกจ็ะพบกบั Workspace แบบเก่าที่

พร้อมส�าหรบัการท�างาน

คลิกเคร่ืองหมายถูกหน้า 
Show “Start” Workspace 
When No Documents Are 
Open ออก หากไม่ต้องการ
แสดง Workspace แบบ Start



17

เริ่มต้นกับ Photoshop CC 2017 02
CHAPTER

ออปชันบาร์ส�าหรับปรับแต่งค่าเครื่องมือที่ใช้เมนูบาร์

Toolbox ส�าหรับเลือกเครื่องมือท�างานกับภาพ ซึ่งใน Photoshop CC 2017 
Toolbox จะปรับเปลี่ยนไปตาม Workspace ที่เลือกใช้งาน

แท็บชื่อภาพ ส�าหรับเลือกท�างานกับ
ภาพ หรอืปิดภาพที่ไม่ต้องการใช้งาน

ชดุพาเนลปรบัแต่ง จะแตกต่างกัน
ไปตาม Workspace ที่เลือกใช้ 

เลือก Workspace

ปุ่มค้นหาสิ่งต่างๆ ใน Photoshop

หลงัจากที่ปิดการแสดง Workspace แบบ Start ไปแล้ว เมื่อเปิดโปรแกรม Photoshop ขึ้นมาอกีครั้ง เราจะพบกบั 

Workspace หลกัซึ่งจะแสดงส่วนประกอบต่างๆ ของ Photoshop ดงันี้

นอกจาก Workspace แบบ Start ที่เราสามารถเลอืกได้ว่าจะซ่อน หรอืแสดงได้ ใน Photoshop CC 2017 ยงัม ี

Workspace แบบ Recent Files ส�าหรบัแสดงไฟล์ล่าสดุในพาเนลที่แยกออกมาต่างหาก การเปิดใช้งานท�าได้โดย

คลกิเมนู Edit > Perferences > General แล้วคลกิเลอืก Show “Recent Files” Workspace When Opening 

a File เมื่อปิด Photoshop แล้วเปิดขึ้นมาใหม่กจ็ะปรากฏ Workspace แบบ Recent Files ขึ้นมาทนัที

NOTE

ตัวอย่างการแสดง Workspace 
แบบ Recent Files ซึ่งจะปรากฏ
พาเนล Recent Files ท�าให้
สามารถเข้าถึงไฟล์เก่าๆ ได้
รวดเร็วขึ้น
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เราสามารถปรบัเปลี่ยนธมีสใีห้หน้าต่างโปรแกรม และสขีอง Artboard หรอืพื้นที่การท�างานได้ โดยคลกิเมนู Edit > 

Preferences > Interface แล้วคลกิเลอืกโทนสขีองหน้าต่างโปรแกรม และสขีอง Artboard ที่ต้องการได้ทนัท ี

แถบค�าสั่งบน Menu Bar
Menu Bar หรอืแถบค�าสั่ง จะเป็นจดุรวบรวมชดุค�าสั่งที่ใช้จดัการกบัไฟล์ภาพบน Photoshop โดยเมนูบาร์แต่ละชดุ

จะใช้จดัการกบัภาพในลกัษณะที่แตกต่างกนัดังต่อไปนี้ 

3เลือกสีของ Artboard ที่ต้องการ หรือเลือก 
Select Custom Color... เพื่อเลอืกสอีื่น

คลิกเลือกธีมสีใหม่
ที่ต้องการ

2

คลกิเมนู Edit>Preferences>Interface1

แสดงธีมสีของหน้าต่างโปรแกรม และสี
ของ Artboard ที่เลือก นอกจากนี้เรายัง
สามารถคลกิขวาบน Arotboard เพื่อเลอืก
สใีหม่ได้ด้วย

4

เมนู รูปแบบการท�างาน

File ใช้จดัการกบัไฟล์ภาพในลกัษณะต่างๆ เช่น สร้างไฟล์ใหม่, เปิดไฟล์ภาพ, บนัทกึไฟล์ภาพ, Import ไฟล์ หรอื 
Export ไฟล์เพื่อท�างานในลกัษณะอื่นๆ

Edit เป็นชดุค�าสั่งในหมวดหมู่ของการแก้ไข เช่น ตดั, คดัลอก, วาง รวมถงึปรบัแต่งค่าเบื้องต้นของโปรแกรม เช่น 
ระบบการจดัการสี

Image เป็นชดุค�าสั่งที่ใช้จดัการภาพ เช่น แก้ไขความสว่าง หรอืสขีองภาพให้สมดลุยิ่งขึ้น รวมถงึใช้ย่อ-ขยายขนาดภาพ 
และก�าหนดขนาดพื้นที่การท�างานของภาพ ซึ่งการใช้ค�าสั่งในเมนูนี้จะมผีลต่อภาพโดยตรง

Layer ใช้จดัการกบัเลเยอร์ของภาพ ไม่ว่าจะเป็นการสร้างเลเยอร์ใหม่, รวมเลเยอร์, แปลงเลเยอร์, จดัการกบัเลเยอร์
ของไฟล์ลกัษณะต่างๆ รวมถงึสามารถจดัการกบัรายละเอยีดของภาพในเลเยอร์นั้นๆ

Type เป็นชดุค�าสั่งที่ใช้จดัการกบัตวัอกัษร

Select ใช้ปรบัแต่ง Selection, บนัทกึและเรยีก Selection มาใช้งาน รวมถงึค�าสั่งส�าหรบัการสร้าง Selection ให้ได้
ผลลพัธ์ที่ดยีิ่งขึ้น

Filter เป็นชดุค�าสั่งส�าหรบัแปลงภาพถ่ายให้มรีูปแบบที่น่าสนใจยิ่งขึ้น รวมถงึการดดั, บิดรูปทรงแบบต่างๆ

3D ใช้ปรบัแต่งไฟล์ 3D ที่น�ามาท�างานใน Photoshop CC รวมถงึการสร้างวตัถ ุ3 มติเิพื่อใช้ร่วมกบัการออกแบบอื่นๆ

View ใช้เลอืกรูปแบบการแสดงผล เช่น ซูมภาพ, แสดงไม้บรรทดั, แสดงเส้นกรดิ หรอืเส้นไกด์

Window ใช้เลอืกแสดง-ปิดพาเนลปรบัแต่งภาพ รวมถงึก�าหนดรูปแบบการแสดงวนิโดว์ในแบบต่างๆ

Help ใช้แสดงความช่วยเหลอืเกี่ยวกบัการใช้เครื่องมอื หรอืค�าสั่งในรูปแบบต่างๆ
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เลือก Workspace ให้เหมาะสมกับการท�างาน
Workspace คอื พื้นที่การท�างานที่เราสามารถเลอืกได้ว่าต้องการใช้งานพาเนลใดบ้าง ใน Photoshop CC 2017 จะ

ม ีWorkspace หลกัให้เลอืกใช้อยู่ 6 แบบ ได้แก่

• Essentials เป็น Workspace พื้นฐานที่เหมาะกบัการ

ท�างานทกุรปูแบบ เนื่องจากมพีาเนลที่ครอบคลมุงาน

ทั่วไปให้ใช้งานอยู่แล้ว 

• 3D เป็น Workspace ที่เน้นท�างานด้านการสร้าง 3D

• Graphic and Web เป็น Workspace ส�าหรับการ

ท�างานด้านกราฟิก และตัวอักษรส�าหรับงานทั่วไป

และเวบ็ไซต์

• Motion เป็น Workspace ที่เน้นท�างานด้านการสร้าง 

Animation

• Painting เป็น Workspace ส�าหรับการท�างานด้าน 

วาดภาพและระบายส ีใช้งานร่วมกบั Tablet ได้ดี

• Photography เป็น Workspace ส�าหรับงานด้าน

ภาพถ่ายโดยเฉพาะ แต่จะเน้นด้านโทนความสว่าง 

แสงเงา และสสีนัของภาพเป็นหลกัคลิกแล้วเลือก Workspace ที่ต้องการ

นอกจาก Workspace ทั้ง 6 แบบที่กล่าวมาแล้ว ยงัม ีWorkspace แบบ Start และ Recent Files ซึ่งสามารถซ่อน

หรอืแสดงด้วยการก�าหนดออปชนัเพิ่มเตมิ โดยคลกิเมนู Edit > Preferences > General แล้วคลกิเลอืก Show 

“Start” Workspace When No Documents Are Open  และ Show “Recent Files” Workspace When Opening a 

File เมื่อปิด Photoshop แล้วเปิดขึ้นมาใหม่กจ็ะปรากฏ Workspace ทั้ง 2 แบบนี้ให้ใช้งาน

NOTE

Workspace แบบ Start และ 
Recent Files ท่ีสามารถซ่อน 
หรือแสดงหากต้องการเรียก 
ใช้งาน
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สร้าง Workspace ไว้ใช้งานเอง 
การสร้าง Workspace จะมจีดุประสงค์เพื่อให้ท�างานสะดวกขึ้น เราสามารถเปิดพาเนลที่ใช้งานบ่อยๆ หรอืปิดพาเนล

ที่ไม่เคยใช้งานเลยไปได้ ซึ่งจะช่วยเพิ่มพื้นที่การท�างานได้มากขึ้น โดยวธิสีร้าง Workspace มขีั้นตอนดงันี้

จัดต�าแหน่งพาเนลที่เปิดขึ้นมาใหม่
ให้อยู่ในต�าแหน่งที่ต้องการ

3

คลิกปุ ่มลูกศร 
แล้วเลอืก New 
Workspace...

4

ตั้งชื่อ Workspace 
แล้วคลกิป่มุ Save 
ก็เป็นอันเสร็จสิ้น
ขั้นตอน

5

คลกิเมน ูWindow แล้วเลอืกพาเนล
ที่ต้องการน�ามาใช้งาน

2

คลกิขวาแล้วเลอืกค�าสั่ง Close 
หรอื Close Tab Group เพื่อปิด

พาเนลที่ไม่ต้องการ

1
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รีเซต Workspace กลับมาเหมือนเดิม
กรณีที่เราเลือกใช้ Workspace แล้วมีการเปลี่ยน

ต�าแหน่งพาเนลไปไว้จุดอื่น จนพื้นที่การท�างานยุ่งเหยิง 

เราสามารถรเีซตได้โดยคลกิเลอืก Reset my workspace 

กจ็ะได้ Workspace แบบเก่ากลบัมาใช้งานทนัที

คลิกเลือก Reset เพื่อเรียกค่าเดิมกลับคืนมา

ลบ Workspace ที่ไม่ต้องการ
การลบ Workspace จะท�าได้กบั Workspace ที่สร้างขึ้นเอง 

ท�าได้ด้วยการคลกิเลอืก Delete Workspace... หลงัจากนั้นเลอืก

ชื่อ Workspace ที่ไม่ต้องการ หรอืเลอืก All Custom Workspaces 

เพื่อลบ Workspace ที่สร้างขึ้นเองทิ้งทั้งหมด 

ตัวอย่างการเลือกลบ Workspace ที่ไม่ต้องการทิ้งไป

สลับโหมดการแสดงภาพ 
นอกจากเลอืก Workspace ให้เหมาะสมแล้ว เรายงัเลอืกโหมดการแสดงภาพแบบเตม็จอ เพื่อซ่อนพาเนลต่างๆ ท�าให้

มพีื้นที่การท�างานกว้างขึ้นได้ โหมดการแสดงภาพม ี3 แบบ ซึ่งสามารถเปลี่ยนได้โดยคลกิปุ่ม  ด้านล่าง Toolbox หรอื

กดป่มุ F  เพื่อสลบัโหมดได้ ส�าหรบัโหมดการแสดงภาพทั้ง 3 แบบมดีงันี้

Standard Screen Mode โหมดการแสดงปกติ ซึ่งเป็นโหมด

มาตรฐาน มเีครื่องมอืส�าหรบัการท�างานที่ครบถ้วน

Full Screen Mode With Menu Bar มีลักษณะเช่นเดียวกับ 

Standard Screen Mode แต่หน้าต่างโปรแกรมจะแสดงภาพเตม็จอภาพ

Full Screen Mode โหมดการแสดงภาพเตม็จอ โดยซ่อน Toolbox 

และพาเนลปรบัแต่ง แต่จะสามารถแสดงได้เมื่อเลื่อนเมาส์ไปด้านข้าง 

หรอืกดป่มุ  เพื่อแสดง Toolbox และพาเนลต่างๆ
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นอกจากการเปลี่่ยนโหมดแสดงภาพแล้ว เรายงัสามารถซ่อนแถบเครื่องมอืต่างๆ หรอืเลอืกซ่อนเฉพาะพาเนลได้อย่าง

รวดเรว็ โดยการกดปุ่ม +  เพื่อซ่อนพาเนล หรอืกดป่มุ  เพื่อซ่อนเครื่องมอืทั้งหมดจากหน้าจอโปรแกรม

ตัวอย่างการแสดงวินโดว์ภาพแบบปกติ กดปุ่ม +  เพื่อซ่อนพาเนล กดปุ่ม  เพ่ือซ่อนทั้งพาเนล
และ Toolbox

เรียงหน้าต่างภาพด้วย Arrange Documents
เราสามารถปรบัเปลี่ยนการจดัเรยีงหน้าต่างภาพใหม่ เพื่อให้ท�างานร่วมกนัได้เรว็ขึ้น จากการคลกิเมนู Window > 

Arrange หลงัจากนั้นเลอืกรูปแบบการจดัเรยีงได้ตามต้องการ

กรณทีี่เปิดภาพท�างานหลายๆ หน้าต่าง เราสามารถใช้ค�าสั่งในกลุ่ม Arrange Documents ช่วยก�าหนดรูปแบบการ

แสดงภาพได้ เช่น แสดงหน้าตา่งภาพแบบ Float หรอืการซมูภาพให้เตม็หน้าจอทกุภาพพร้อมกนั ดงัรายละเอยีดต่อไปนี้

• Cascade คอื การจดัเรยีงหน้าต่างภาพแบบ Flaot ให้เป็นระเบยีบ

• Tile คอื การจดัเรยีงหน้าต่างภาพให้มขีนาดเท่าๆ กนั

• Float in Window คอื เปลี่ยนหน้าต่างภาพที่เลอืกอยู่เป็นหน้าต่างแบบ Float

• Float all in Windows ก�าหนดการแสดงหน้าต่างภาพแบบลอยเหมอืนเวอร์ชันเก่า

• Match Zoom ย่อ-ขยายเปอร์เซน็ต์ให้เท่ากบัวนิโดว์ภาพที่เลอืกอยู่

• Match Location ก�าหนดต�าแหน่งการแสดงภาพในจดุเดยีวกบัวนิโดว์ภาพที่เลอืกอยู่

• Match Rotation คอื การหมนุภาพของทกุหน้าต่างภาพในองศาเดยีวกนั

• Match All คอื การขยายภาพทกุภาพให้มขีนาดเท่าๆ กนั

ตัวอย่างการจัดเรียงหน้าต่างภาพด้วยค�าสั่ง Arrange เลือกรูปแบบการจัดเรียงหน้าต่างภาพท่ีต้องการ 
มีถึง 10 แบบด้วยกัน
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ใช้งานเครื่องมือเบื้องต้น
ก่อนที่เราจะท�างานกับภาพใน Photoshop สิ่งแรกที่ควรท�าความเข้าใจคือ การใช้งานเครื่องมือพื้นฐานต่างๆ เช่น 

การย่อ-ขยาย หรอืหมนุภาพเพื่อให้สามารถท�างานได้ตรงจดุมากยิ่งขึ้น โดยมี

ย่อ-ขยายภาพด้วยเครื่องมือ Zoom Tool
 (Zoom Tool) เป็นเครื่องมอืส�าหรบัย่อหรอืขยายภาพเพื่อให้เหน็รายละเอยีดที่ชดัเจนขึ้น ซึ่งมวีธิกีารใช้งานง่ายๆ ดงันี้

จากการท�างานที่ผ่านจะเห็นว่า หากคลิกเครื่องมือ  (Zoom Tool) ค้างไว้ ภาพก็จะขยายขึ้นเรื่อยๆ ซึ่งเป็น

ผลจากออปชัน Scrubby Zoom แต่หากต้องการขยายภาพแบบเวอร์ชันเก่าคือ แดรกเมาส์เลือกจุดที่ขยายเอง ท�าได้

โดยคลกิเครื่องหมายถูกหน้า Scrubby Zoom บนออปชนับาร์ออกไป หรอืหากต้องการก�าหนดค่าอื่นๆ กก็�าหนดได้ดงั 

รายละเอยีดต่อไปนี้

เมื่อต้องการย่อภาพ ให้กดปุ่ม  
ค้างไว้ แล้วใช้เครื่องมือ  (Zoom 
Tool) คลกิลงไปบนภาพ

3

นอกจากการย่อ-ขยายภาพด้วยเครื่องมอื  (Zoom Tool) แล้ว เรายงัสามารถย่อ-ขยายภาพด้วยคย์ีลดัได้ด้วยดงันี้

• กดป่มุ  ค้างไว้ แล้วกดปุ่มเครื่องหมายบวก เมื่อต้องการขยายภาพ

• กดป่มุ  ค้างไว้ แล้วกดปุ่มเครื่องหมายลบ เมื่อต้องการย่อภาพ

• กดป่มุ  ค้างไว้ แล้วกดปุ่มเลขศูนย์ เมื่อต้องการแสดงภาพให้พอดหีน้าจอ

NOTE

เปิดภาพที่ต้องการขึ้นมา แล้วคลกิเครื่องมอื  (Zoom Tool)1

2คลิกบนส่วนที่ต้องการขยายค้างไว้ 
กจ็ะเหน็รายละเอยีดชดัเจนขึ้น
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ใช้งานเครื่องมือ Hand Tool 
 (Hand Tool) เป็นเครื่องมอืที่ใช้เลื่อนดูส่วนต่างๆ 

ของภาพ จะใช้งานได้เมื่อภาพถกูขยายเกนิขนาดหน้าต่าง

ภาพ การใช้งานสามารถท�าได้ง่ายๆ เพยีงแค่ใช้เครื่องมอื 

 (Hand Tool) คลกิแล้วแดรกเมาส์ไปยงัจดุที่ต้องการ

คลิกแล้วแดรกเมาส์ เพื่อเลื่อนดูส่วนต่างๆ ของภาพ

แดรกเมาส์เลื่อนดูส่วนต่างๆ ของภาพ

ย่อ-ขยายขนาดของภาพ

เราสามารถขยายภาพ 

100% อย่างรวดเร็วได้

อีกวิธี โดยดับเบิลคลิก

ที่เครื่องมือ  (Zoom 

Tool) 

NOTE

คลิกเครื่องหมายถูกหน้า Scrubby Zoom 
ออกไป เพื่อขยายภาพด้วยวิธีการแดรกเมาส์ แสดงภาพ 100% แสดงภาพเต็มความกว้างจอ

แสดงภาพพอดีจอ

อีกวิธีที่ีนิยมใช้ในการย่อหรือขยายภาพคือ การใช้

พาเนล Navigator โดยคลกิเมนู Window > Navigator เรา

กจ็ะสามารถเลื่อนดูส่วนต่างๆ ของภาพ รวมถงึย่อ-ขยาย

ขนาดของภาพได้ด้วย 

ขณะที่เราท�างานโดยใช้เครื่องมอือื่นอยู่ กส็ามารถเลื่อนดูส่วนต่างๆ ของภาพโดยไม่ต้องเปลี่ยนเครื่องมอืได้ โดย

ให้กดป่มุ  เพื่อเปลี่ยนสถานะเครื่องมอืเป็น  (Hand Tool) ชั่วคราว หรอืดบัเบลิคลกิเครื่องมอื  

(Hand Tool) เพื่อย่อ-ขยายภาพให้พอดกีบัหน้าจอ

NOTE



25

เริ่มต้นกับ Photoshop CC 2017 02
CHAPTER

หมุนภาพด้วยเครื่องมือ Rotate 

View Tool
 (Rotate View Tool) ใช้หมุนกระดานวาด หรือ 

Canvas ให้มอีงศาต่างไปจากเดมิ มปีระโยชน์ส�าหรบัการ

ปรบัแต่งภาพที่อยู่ในมมุที่ยากต่อการท�างาน

กรอกองศาที่ต้องการหมุนเอง

รีเซตค่าให้ภาพอยู่ในมุมมองปกติ

ใช้เครื่องมือ  (Rotate View Tool) คลิกแล้วแดรก
เมาส์ เพ่ือหมนุภาพให้อยู่ในมมุทีเ่หมาะสมในการท�างาน 

การใช้งานและปรับแต่งไม้บรรทัด (Ruler)
ไม้บรรทดัจะถูกน�ามาใช้ เมื่อต้องการก�าหนดจดุเริ่มต้นในการจดัวางวตัถบุนภาพ หรอืเมื่อต้องการความแม่นย�าใน

การจดัวางระยะวตัถ ุเราจะเรยีกใช้ หรอืซ่อนไม้บรรทดัได้โดยกดปุ่ม + R  โดยมกีารใช้งานพื้นฐานดงันี้ 

กดป่มุ + R  เพื่อเปิดใช้ไม้บรรทดั1

แดรกเมาส์จากไม้บรรทดัลงด้านล่าง เพื่อสร้าง
เส้นไกด์ เมื่อปล่อยเมาส์ก็จะได้เส้นไกด์สีฟ้า 
และสามารถสร้างขึ้นใหม่ได้ด้วยวธิกีารเดมิ

3

คลกิขวาบนไม้บรรทดั แล้วเลอืกหน่วย
ใหม่ที่ต้องการ เช่น Pixels

2
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ในบางกรณีเราอาจต้องเปลี่ยน

จุดเริ่มต้นของไม้บรรทัดใหม่ เพื่อ

ก�าหนดจุดเริ่มต้นการท�างานไปที่

ส่วนอื่นของภาพ กส็ามารถท�าได้ดงันี้

แดรกเมาส์จากมมุไม้บรรทดัไปยงัจดุเริ่มต้นใหม่1

การใช้งานและปรับแต่งเส้นไกด์ (Guide)
เส้นไกด์หรือเส้นบอกแนว เป็นตัวเลือกที่มักถูกน�ามาใช้เมื่อต้องการก�าหนดต�าแหน่งเพื่อวางวัตถุ หรือใช้ระบุจุด 

เริ่มต้นการ Selection ให้แม่นย�าขึ้น การใช้งานเส้นไกด์มวีธิกีารดงันี้

เมื่อปล่อยเมาส์ จุดเริ่มต้นไม้บรรทัดจะ
เปลี่ยนไป สามารถสร้างเส้นไกด์ได้ทนัที

2

ในกรณทีี่เส้นไกด์มสีกีลนืไปกบัฉากหลงั อาจท�าให้ท�างานไม่สะดวก เราสามารถเปลี่ยนสเีส้นไกด์ใหม่ได้ดงัขั้นตอน

ต่อไปนี้

เมื่อต้องการย้ายต�าแหน่งเส้นไกด์ ให้ใช้เครื่องมอื  (Move Tool) 
คลกิแล้วแดรกเมาส์เปลี่ยนไปยงัต�าแหน่งใหม่ได้

1

เมื่อต้องการลบเส้นไกด์ ให้ใช้เครื่องมอื  (Move 
Tool) แดรกเมาส์ออกมาด้านนอกกรอบภาพ

2

เลือกสีเส้นไกด์ใหม่ได้
ตามต้องการ หลงัจากนั้น
คลกิป่มุ OK

4

ใช้เครื่องมอื  (Move Tool) ดบัเบลิคลกิเส้นไกด์ที่สร้างไว้3
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ตั้งแต่ Photoshop CC 2014 เป็นต้นมา ได้ปรบัปรงุให้ Smart Guide ท�างานได้ดขีึ้น ซึ่งไม่เพยีงแค่บอกต�าแหน่งวตัถุ

เหมือนในเวอร์ชันเก่า แต่ยังสามารถแสดงเส้นไกด์บอกแนววัตถุ และบอกระยะห่างให้รู้ว่าวัตถุห่างกันเป็นระยะเท่าใด 

เมื่อต้องการใช้งาน Smart Guide สามารถท�าได้โดยคลกิเมนู View > Show > Smart Guides

เราสามารถจดัการกบัเส้นไกด์แบบอื่นๆ ได้อกี 

เช่น ลอ็คเส้นไกด์ไม่ให้เปลี่ยนต�าแหน่งได้ โดย

คลกิเมนู View > Lock Guide หรอืคลกิเมนู 

View > Clear Guide เมื่อต้องการลบเส้นไกด์ 

ทั้งหมดออก นอกจากนี้เรายังสามารถสร้าง

เส้นไกด์โดยการก�าหนดต�าแหน่งตามหน่วย

ของไม้บรรทดัได้ โดยคลกิเมนู View > New 

Guide

NOTE

ได้สขีองเส้นไกด์ใหม่ที่ชดัเจนยิ่งขึ้น5

เมื่อใช้เครื่องมือ  (Move Tool) แดรกเมาส์เพื่อเปลี่ยนต�าแหน่ง
วัตถุ จะปรากฏระยะห่างของวัตถุขึ้นมา

เมือ่กดปุ่ม  แล้วใช้เคร่ืองมอื  (Move Tool) แดรกเมาส์เพือ่
ก็อปปี้วัตถุอีกครั้ง ก็จะปรากฏระยะห่างของวัตถุขึ้นมา ซึ่งช่วยให้เรา
สามารถจัดระยะวัตถุให้ห่างเท่าๆ กันได้ทันที

การใช้งานเส้นกริด (Grid)
เส้นกริดคือ ตารางสีเทาที่คลุมทั่วทั้งภาพ จะมีประโยชน์เมื่อต้องการก�าหนดระยะวัตถุให้อยู่ในต�าแหน่งที่ต้องการ

ท�าได้อย่างแม่นย�าด้วยคณุสมบตั ิSnap to Grid ซึ่งเรยีกใช้งานได้จากการคลกิเมนู View > Snap to > Grid 

กดปุ่ม +  เพื่อ
แสดงเส้นกรดิบนภาพ

1

เมื่อใช ้ เครื่องมือ  
(Move Tool) ย้ายข้อความ
แล้ว กจ็ะสามารถจดัวาง
ต�าแหน่งได้แม่นย�าขึ้น

2
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ท�าความรู้จักกับพาเนลปรับแต่งภาพ
พาเนล (Panel) เป็นส่วนที่ใช้ท�างานกับภาพแบบต่างๆ เช่น การเลือกใช้สีจากพาเนล Color, การตกแต่งสีสันให้

ภาพถ่ายจากพาเนล Adjustments เป็นต้น เราสามารถจดัการกบัพาเนลให้เป็นระเบยีบเรยีบร้อยได้ดงัหลกัการต่อไปนี้

เรียกใช้ค�าสั่งเสริมของพาเนล
การท�างานกับพาเนลบางประเภทจ�าเป็นต้องเลือกออปชัน

เพิ่มเติม เพื่อแสดงค่าให้เหมาะสมกับประเภทงาน ค�าสั่งเหล่านี้

เรยีกใช้งานได้จากปุ่ม Context Menu โดยค�าสั่งของแต่ละพาเนล

กจ็ะแตกต่างกนัออกไป 

คลิกเพื่อลดขนาดพาเนล

คลิกเพื่อขยายพาเนล
เป็นขนาดเดิม

คลิกเพื่อขยายพาเนลให้ใหญ่ขึ้น

คลิกปุ่มนี้เพ่ือย่อพาเนล
สู่สภาพเดิม

แดรกเมาส์เพ่ือลด
พาเนลเป็นแบบปุ่ม

คลิกเพ่ือเปิดพาเนล
ขึ้นมาใช้งาน

เปลี่ยนต�าแหน่งพาเนลใหม่
เราสามารถเปลี่ยนต�าแหน่งพาเนลบางชดุที่ไม่ได้ใช้บ่อยนกัไปยงัจดุใหม่ได้ โดยมวีธิกีารดงันี้

แดรกเมาส์เลอืกแถบสเีทาหากต้องการย้ายทั้งชดุ หรอื
เลอืกเฉพาะชื่อหากต้องการย้ายเพยีงพาเนลเดยีว

1

น�าพาเนลที่ย้ายมาวางไว้ โดย
สงัเกตเส้นสฟ้ีา ที่แสดงให้ทราบ

ว่าสามารถวางไว้ที่จดุนั้นได้

2
พาเนลที่ได้หลังจากจัดวาง
เรยีบร้อยแล้ว สามารถน�ากลบั

ไปจดุเดมิได้ด้วยวธิเีดยีวกนั

3

คลิกปุ่ม Context Menu เพื่อเรียกใช้ค�าสั่งเสริม

ตัวอย่างการเรียกใช้ค�าสั่ง
เสริมของพาเนลที่ใช้งานอยู่
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ซ่อน-แสดงพาเนล
พาเนลที่ยงัไม่ต้องการใช้งาน เราสามารถซ่อนหรอืพบั

ให้เลก็ลงได้ เพยีงแค่ดบัเบลิคลกิที่พาเนลเท่านั้น

การใช้งานออปชันบาร์
ออปชนับาร์ (Option Bar) เป็นส่วนที่ใช้ปรบัแต่งเครื่องมอื จะมคี่าการท�างานที่แตกต่างไปตามเครื่องมอืที่เลอืกใช้ 

โดยเราสามารถบนัทกึค่าการท�างานของเครื่องมอืที่ใช้งานบ่อยๆ ไว้ใช้ในภายหลงัได้ดงัขั้นตอนต่อไปนี้

ดับเบิลคลิกเพื่อซ่อนพาเนล
หากยังไม่ต้องการใช้งาน

ดับเบิลคลิกเพื่อแสดง
พาเนลในโหมดปกติ

เรียกใช้งานพาเนลอื่นๆ
หากต้องการใช้งานพาเนลอื่นๆ นอกเหนือจากที่ 

Workspace จัดไว้ เราสามารถเปิดขึ้นมาใช้ได้โดยเลือก

จากเมนู Window

คลกิเลอืกเครื่องมอื
ที่ต้องการบนัทกึค่า

1 คลกิป่มุ  (Create new tool preset) 
แล้วตั้งชื่อให้กับ Preset ก็จะสามารถ 
ใช้งานค่าที่ตั้งไว้ในภายหลงัได้ทนัที

4

คลกิปุ่มลูกศร 3 ก�าหนดค่าเครื่องมอืได้ตามต้องการ2

คลิกเพื่อแสดงแถบ
เครื่องมือ 2 แถว

คลิกเพื่อแสดงแถบ
เครื่องมือแถวเดียว

ลักษณะของแถบ
เครื่องมือแบบ 2 แถว

คลิกที่แถบเคร่ืองมือ แล้วปล่อย
บริเวณพาเนลเพื่อจัดต�าแหน่งใหม่

แถบเคร่ืองมือถูกจดัวางไว้ชดิกับพาเนล 
เพื่อการท�างานที่สะดวกยิ่งขึ้น

ท�างานกับกล่องเครื่องมือ (Toolbox)
กล่องเครื่องมือ หรือ Toolbox เป็นชุดเครื่องมือจัดการกับไฟล์งานที่สร้างขึ้น สามารถปรับแต่งให้เหมาะสมขึ้นได้

ด้วยวธิกีารต่อไปนี้
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สญัลกัษณ์รปูลกูศรสดี�า แสดงว่ามเีคร่ืองมอืย่อยอยู่

คลิกค้างไว้ แล้ว
เลือกเครื่องมือ
ย่อยที่ต้องการ

ตัวอักษร M  คือ Shortcut 
ส�าหรับเรียกใช้เครื่องมือในกลุ่มนี้

สัญลักษณ์แสดงว่าเป็น
เครื่องมือที่เลือกใช้อยู่

เราสามารถเปลี่ยนมาใช้เครื่องมืออื่นในกลุ่ม โดยกดปุ่ม  แล้วตามด้วยตัวอักษรที่เป็น Shortcut ของเครื่องมือในกลุ่มที่ต้องการ

เรียกใช้ชุดเครื่องมือย่อย
นอกจากเครื่องมอืที่เราเหน็บน Toolbox แล้ว ยงัมชีดุเครื่องมอืย่อย

ให้เรยีกใช้งานได้อกี โดยให้สงัเกตสญัลกัษณ์รปูลูกศรสดี�าที่มมุด้านล่าง

ขวาของเครื่องมอื หากต้องการใช้งาน ให้คลกิค้างไว้เพื่อเลอืกเครื่องมอื 

ย่อยในกลุ่ม

การเรยีกใช้เครื่องมอืยงัสามารถท�าได้อกีวธิคีอื การกดปุ่ม Shortcut 

บนคีย์บอร์ด โดยปุ่ม Shortcut เหล่านี้จะแสดงอยู่ด้านหลังชื่อของ

เครื่องมอืแต่ละตวั

เครื่องมือของ Photoshop CC 2017
เครื่องมอืต่างๆ ของ Photoshop CC 2017 จะมกีารปรบัเปลี่ยนบ้างเลก็น้อย แต่การแสดงผลของเครื่องมอืนั้นจะปรบั

เปลี่ยนไปตาม Workspace ที่เราเลอืกใช้เพื่อให้สอดคล้องกบัรูปแบบการท�างานมากที่สดุ อย่างไรกต็ามเราสามารถแบ่ง

ประเภทของเครื่องมอืออกเป็นกลุ่มย่อยทั้งหมด 8 กลุ่มดงันี้

A  กลุ่มเครื่องมอืส�าหรบัการ

เลอืกเพื่อย้ายวตัถ ุหรอืรูปภาพ

ไปยงัต�าแหน่งที่ต้องการ รวมถงึ 

สร ้าง Selection เพื่อเลือก

ท�างานกับบางส่วนของภาพ 

เช่น การระบายส ีหรอืลบส่วน

ที่ไม่ต้องการออกไป โดยจะ

ประกอบไปด้วยเครื่องมอืต่างๆ 

ดงันี้

A

เครื่องมือ รูปแบบการท�างาน

 (Move Tool) ใช้เคลื่อนย้ายภาพไปยงัต�าแหน่งใหม่

 (Artboard Tool) ใช้สร้าง Artboard เพิ่มพื้นที่การท�างาน

 (Rectangular Marquee Tool) 
 (Elliptical Marquee Tool)

เครื่องมอืสร้าง Selection กลุ่ม Marquee Tool ใช้
ส�าหรบัสร้าง Selection เป็นรูปทรงพื้นฐาน

 (Lasso Tool) ใช้สร้าง Selection แบบคร่าวๆ โดยการแดรกเมาส์
ไปยงัส่วนที่ต้องการ

 (Polygonal Lasso Tool) ใช้สร้าง Selection ให้กับภาพที่มีขอบเขตเป็น 
เส้นตรง, เส้นหยกั

 (Magnetic Lasso Tool) ใช้สร้าง Selection ให้กบัภาพที่มขีอบเขตชดัเจน
โดยการคลกิไปตามเส้นขอบ

 (Quick Selection Tool) ใช้สร้าง Selection ให้กับภาพที่ขอบเขตชัดเจน
โดยการแดรกเมาส์ผ่าน

 (Magic Wand Tool) ใช้สร้าง Selection โดยยึดตามสีที่ใกล้เคียงกัน 
เหมาะกบัภาพที่มสีไีม่ซบัซ้อนมากนกั
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B  กลุ่มเครื่องมอืส�าหรบัการตดัภาพเพื่อเลอืกเฉพาะส่วนB
C

D

F

G

H

E

เครื่องมือ รูปแบบการท�างาน

 (Crop Tool) ใช้ส�าหรับตัดภาพขนาดใหญ่ให้เหลือ
เฉพาะพื้นที่ที่ต้องการ

 (Perspective Crop Tool) ใช ้ ส� าหรับตั ดภาพมุมมองแบบ  
Perspective ให้กลายเป็นมมุมองปกติ

D  กลุ่มเครื่องมอืส�าหรบัการรทีชัภาพ โดยแบ่งเป็นกลุ่มเครื่องมอื

ย่อยๆ ได้แก่ กลุ่มการแก้ไขพื้นผวิ กลุ่มส�าหรบัการตดัฉากหลงั กลุ่ม

ส�าหรบัปรบัความคมชดั และกลุ่มส�าหรบัปรบัแต่งสเีฉพาะจดุ

C  กลุ่มเครื่องมอืส�าหรบัเกบ็ค่าส ีและเกบ็ค่าสเีพื่อใช้เปรยีบเทยีบ

เครื่องมือ รูปแบบการท�างาน

 (Eyedropper Tool) ใช้ส�าหรับเลือกสีจากภาพเพื่อน�าไป 
ใช้งานต่อ

 (Color Sampler Tool) ใช ้ส�าหรับดูดสีตัวอย่างไว ้ส�าหรับ 
เปรยีบเทยีบค่า

เครื่องมือ รูปแบบการท�างาน

 (Spot Healing Brush Tool) ใช้รีทัชแก้ไขพื้นผิวที่เป็นจุดบกพร่อง
เลก็ๆ บนภาพ

 (Healing Brush Tool) ใช้รีทัชแก้ไขพื้นผิวที่เป็นจุดบกพร่อง
ขนาดใหญ่

 (Patch Tool) ใช้รีทัชแก้ไขพื้นผิวขนาดใหญ่ โดย
การน�าพื้นผวิอื่นมาแปะทบั

 (Content-Aware Move 
Tool)

ใช้ย้ายวัตถุในภาพไปยังต�าแหน่งใหม่ 
โดยเครื่องมอืจะเตมิพื้นหลงัให้ด้วย

 (Clone Stamp Tool) ใช้รีทัชภาพโดยการก็อปปี้พื้นผิวมา
แปะทบัจดุที่มปีัญหา

 (Pattern Stamp Tool) ใช้รีทัชภาพโดยการเติมพื้นผิว หรือ 
Pattern ลงไป

 (Eraser Tool) ใช้ลบส่วนที่ไม่ต้องการออกจากภาพ

 (Background Eraser Tool) ใช้ลบพื้นหลังออกจากภาพ โดยการ
แดรกเมาส์ไปบนสทีี่ไม่ต้องการ

 (Magic Eraser Tool) ใช้ลบพื้นหลังออกจากภาพ โดยการ
คลกิเมาส์บนสทีี่ไม่ต้องการ เหมาะสม 
กับภาพที่มีพื้นหลังเป ็นสีพื้นที่ไม ่
ซบัซ้อนนกั

 (Blur Tool) ใช้ปรับแต่งภาพให้เบลอ นุ่มนวลขึ้น
โดยการแดรกเมาส์บนส่วนที่ต้องการ
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E  กลุ่มเครื่องมอืส�าหรบัการระบายส ีและการลงสดี้วยวธิตี่างๆ โดยมกีลุ่มย่อยแบ่งตามการใช้งาน เช่น การระบายส ี

วาดเส้น แปลงภาพเป็นภาพวาดระบายส ีหรอืการลงสแีบบไล่โทน เป็นต้น

F  กลุ่มเครื่องมอืส�าหรบัสร้าง และจดัการรูปทรงแบบเวคเตอร์ และการสร้างตวัอกัษร

G  กลุ่มเครื่องมอืส�าหรบัจดัการกบัมมุมองของภาพ มทีั้งหมด 3 ตวัดงันี้

เครื่องมือ รูปแบบการท�างาน

 (Brush Tool) ใช้ระบายสบีนภาพ ซึ่งสามารถก�าหนดให้เป็นได้ทั้งสพีื้น หรอืเส้นที่เป็นลวดลาย

 (Pencil Tool) ใช้ระบายสีบนภาพ ซึ่งสามารถก�าหนดให้เป็นได้ทั้งสีพื้น หรือเส้นที่เป็นลวดลายต่างๆ 
ลกัษณะเส้นที่ได้จะมคีวามหยาบมากกว่าเครื่องมอื  (Brush Tool)

 (Art History Brush Tool) ใช้แปลงภาพถ่ายให้กลายเป็นภาพวาดแบบง่ายๆ

 (History Brush Tool) ใช้แดรกเมาส์ไปบนภาพเพื่อเรยีกคนืค่าต้นฉบบั

 (Gradient Tool) ใช้แดรกเมาส์ไปบนภาพเพื่อสร้างแถบสแีบบไล่โทน

เครื่องมือ รูปแบบการท�างาน

 (Horizontal Type Tool) ใช้สร้างข้อความแนวนอนปกติ

 (Vertical Type Tool) ใช้สร้างข้อความแนวตั้ง

 (Pen Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงแบบอสิระ

 (Freeform Pen Tool) ใช้สร้างเส้นพาธตามขอบของภาพ หรอืรูปทรง

 (Add Anchor Point Tool) ใช้เพิ่มจดุแองเคอร์เพื่อให้สามารถดดั หรอืปรบัแต่งเส้นพาธได้ละเอยีดขึ้น

 (Delete Anchor Point Tool) ใช้ลบจดุแองเคอร์ออกจากเส้นพาธ

 (Convert Point Tool) ใช้ปรบัเส้นพาธให้เป็นมมุ หรอืเป็นเส้นโค้งโดยคลกิ หรอืแดรกเมาส์จดุแองเคอร์

 (Path Selection Tool) ใช้เลอืกเส้นพาธที่สร้างไว้เพื่อเคลื่อนย้าย

 (Direct Selection Tool) ใช้เลอืกจดุแองเคอร์บนเส้นพาธเพื่อปรบัแต่งต�าแหน่ง

เครื่องมือ รูปแบบการท�างาน

 Hand Tool (H) ใช้ส�าหรบัเลื่อนดูส่วนต่างๆ ของภาพ

 Rotate View Tool (R) ใช้ส�าหรบัหมนุ-เอยีงภาพให้อยู่ในองศาที่ง่ายต่อการท�างาน

 Zoom Tool (Z) ใช้ส�าหรบัย่อ-ขยายมมุมองการแสดงภาพ

เครื่องมือ รูปแบบการท�างาน

 (Sharpen Tool) ใช้ปรบัแต่งภาพให้คมชดัขึ้น โดยการแดรกเมาส์บนส่วนที่ต้องการ

 (Smudge Tool) ใช้เกลี่ยสใีห้ส่วนที่แดรกเมาส์ผ่าน โดยการแดรกเมาส์บนส่วนที่ต้องการ

 (Dodge Tool) ใช้ปรบัภาพให้สว่างขึ้นเฉพาะจดุ โดยการแดรกเมาส์บนส่วนที่ต้องการ

 (Burn Tool) ใช้ปรบัภาพให้มดืลงเฉพาะจดุ โดยการแดรกเมาส์บนส่วนที่ต้องการ

 (Sponge Tool) ใช้ดูดสขีองภาพให้ซดีลง หรือเพิ่มความสดให้ภาพ โดยการแดรกเมาส์บนส่วนที่ต้องการ
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H  กลุ่มเครื่องมอืที่ไม่ค่อยได้ใช้งานเท่าใดนกั Photoshop CC 2017 จงึจดัการรวมเป็นชดุเดยีวกนั เพื่อให้เครื่องมอืที่ถูก

ใช้งานบ่อยเรยีกใช้งานได้สะดวกขึ้น โดยเครื่องมอืในชดุนี้จะคละรวมกนัหลากหลายรูปแบบดงันี้

เครื่องมือ รูปแบบการท�างาน

 (Single Row Marquee Tool) สร้าง Selection เป็นเส้นตรงแนวนอนความสูง 1 พกิเซล

 (Single Column Marquee Tool) สร้าง Selection เป็นเส้นตรงแนวตั้งความกว้าง 1 พกิเซล

 (Slice Tool) ใช้ส�าหรบัหั่นภาพขนาดใหญ่เป็นชิ้นเลก็ๆ ส�าหรบัน�าไปใช้ออกแบบเวบ็เพจ

 (Slice Select Tool) ใชส�าหรบัปรบัแต่งภาพที่หั่นด้วยเครื่องมือ  (Slice Tool) ให้สมบูรณ์ยิ่งขึ้น

 (3D Material Eyedropper Tool) ใช้ส�าหรบัเลอืกส ีหรอืพื้นผวิของภาพไปใช้กบังาน 3 มติิ

 (Ruler Tool) ใช้ส�าหรบัวดัระยะระหว่างจดุ 2 จดุ หรอืแก้ไขภาพเอยีง

 (Note Tool) ใช้ส�าหรบัแทรกโน้ตไปบนภาพ เพื่อแจ้งผู้ที่ท�างานร่วมกนัให้ทราบความคดิเหน็

 (Count Tool) ใช้ส�าหรบันบัจ�านวนวตัถภุายในภาพ

 (Red Eye Tool) ใช้แก้ไขภาพถ่ายบคุคล ที่มีปัญหาแสงแฟลชกระทบท�าให้เกดิตาแดง

 (Color Replacement Tool) ใช้แปลงภาพถ่ายให้กลายเป็นภาพวาด ซึ่งจะมฝีีแปรงเช่นเดยีวกบัการใช้พู่กนั

 (Paint Bucket Tool) ใช้คลกิเพื่อเทสลีงไปในภาพ หรอื Selection ที่สร้างไว้

 (3D Material Drop Tool) ใช้ส�าหรบัเทส ีหรอืพื้นผวิลงในวตัถ ุ3 มติทิี่สร้างขึ้น

 (Horizontal Type Mask Tool) ใช้สร้างข้อความแนวนอนแบบ Selection

 (Vertical Type Mask Tool) ใช้สร้างข้อความแนวตั้งแบบ Selection

 (Rectangle Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงแบบส่ี่เหลี่ยม

 (Rounded Rectangle Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงแบบส่ี่เหลี่ยมขอบมน

 (Ellipse Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงแบบวงกลม

 (Polygon Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงหลายเหลี่ยม

 (Line Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงแบบเส้นตรง

 (Custom Shape Tool) ใช้สร้างเส้นพาธ หรอืรูปทรงอสิระที่โปรแกรมจดัเตรยีมไว้ให้

ค้นหาเครื่องมือ, ทิป หรือภาพสต็อก
ใน Photoshop CC 2017 ได้เพิ่มฟีเจอร์ใหม่ที่เรยีกว่า In-App Search ที่ช่วยให้เราสามารถค้นหาสิ่งที่ต้องการภายใน 

Photoshop มาใช้งานได้รวดเรว็ขึ้น โดยสิ่งที่เราจะค้นหาได้มอียู่ 3 อย่าง ได้แก่ เครื่องมอื, ทปิ เทคนคิ Tutorial และภาพ

จาก Adobe Stock ซึ่งการค้นหาท�าได้ดงันี้
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1คลกิป่มุ  (Search) บนออปชนับาร์ หรอืกดป่มุ +

ในกรณีที่ต้องการค้นหาวิธีการใช้งานเครื่องมือ ทิป 
เทคนคิต่างๆ ให้คลกิเลอืก Learn

4

ปรากฏหวัข้อที่เกี่ยวข้องกบัคยี์เวริ์ดที่เราค้นหา5

ในกรณทีี่ต้องการค้นหาภาพจาก Adobe Stock มา
ใช้งาน ให้คลกิเลอืก Stock

7

เมื่อคลกิหวัข้อที่ต้องการเรยีนรู้ กจ็ะปรากฏเวบ็ไซต์ 
ที่มรีายละเอยีดที่ต้องการเรยีนรู้ขึ้ึนมาทนัที

6

กรอกสิ่งที่ต้องการ
ค้นหา เช่น กรอก
คี ย ์ เ วิ ร ์ ด  P e n 
ลงไป กจ็ะปรากฏ 
ร า ย ล ะ เ อี ย ด ที่
เ กี่ ย ว ข ้ อ ง กั บ
คีย ์ เวิร ์ดทั้งหมด

นั้นขึ้นมา

2

ในกรณทีี่เป็นการ
ค้นหาเครื่องมือ 
ก็สามารถคลิก
เลือกเครื่องมือที่
ต้องการใช้งาน
ได้ทนัที

3

จะปรากฏภาพตามคีย์เวิร์ดที่
เราค้นหาขึ้นมา ซึ่งสามารถ
คลิกบนภาพที่ต้องการเพื่อน�า

มาใช้งานได้ทนัที

8



ทํางานกับ
ไฟลภาพเบื้องตน03

CHAPTER

ในบทน้ีผูอานจะไดทําความรูจักกับไฟลภาพแบบตางๆ ที่นํามาใช

ใน Photoshop ได รวมถึงวิธีจัดการกับไฟลภาพ ไมวาจะเปนการเปด

ไฟลภาพอยางรวดเร็ว สรางไฟลใหมใหเหมาะสม วิธีจัดการกับความ

ละเอียดที่แสดงบนจอภาพ ความละเอียดของภาพในการพิมพ รวมถึง

การกําหนดขนาดของไฟลภาพใหเหมาะสมกับการใชงานดวย
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รู้จักกับคุณลักษณะของภาพ
ภาพที่น�ามาใช้ในโปรแกรมกราฟิกอย่าง Photoshop มหีลายแบบ แต่หากแยกเป็นกลุ่มใหญ่ๆ จะแบ่งได้เป็น 2 กลุ่ม

หลกัคอื ภาพแบบ Bitmap และภาพแบบ Vector

800% 1600%

100%

100%

800% 1600%

ตัวอย่างภาพบติแมปทีข่ยายในระดบัทีต่่างกัน 
จะเห็นเม็ดสีหรือพิกเซลที่ชัดเจน

ตัวอย่างภาพแบบเวคเตอร์ที่ีข่ยายในระดบัทีต่่างกัน 
แต่ว่ายังสามารถแสดงรายละเอียดได้อย่างชัดเจน

ลักษณะเด่นของภาพแบบ JPEG คือ การแสดงสีได้อย่างสมจริง และตกแต่ง
เพิ่มเติมได้อีกมากมาย

ภาพแบบ Bitmap
ภาพแบบ Bitmap (บติแมป) หรอืภาพแบบ Raster เกดิ

จากพิกเซล (Pixel) หรือเม็ดสีรูปทรงสี่เหลี่ยมจัตุรัสที่มีสี

แตกต่างกนั มาเรยีงต่อกนัจนเกดิเป็นภาพขึ้นมา ข้อดขีอง

ภาพลกัษณะนี้คอื จะมสีทีี่เป็นธรรมชาต ิไล่โทนสไีด้สมจรงิ 

ภาพส่วนใหญ่ที่ใช้งานมกัจะเป็นภาพแบบบติแมปนั่นเอง

ภาพแบบ Vector
ภาพแบบ Vector (เวคเตอร์) เป็นภาพแบบลายเส้น

ที่ผสมกันระหว่างเส้นโค้ง เส้นตรง และมุมจนเกิดเป็น 

รูปทรงต่างๆ เกดิจากการสร้างสรรค์ด้วยโปรแกรมกราฟิก 

เช่น Illustrator หรือ Flash แต่สามารถน�ามาใช้งานใน 

Photoshop ได้ มีข้อดีคือ ย่อ-ขยายขนาดได้โดยภาพไม่

สูญเสยีรายละเอยีด  

ชนิดของไฟล์ภาพ
ชนดิของไฟล์ภาพจะถกูแยกตามนามสกลุ

ไฟล์ เป็นตวัระบรุูปแบบเฉพาะ เช่น เป็นภาพ

ที่แสดงสไีด้อย่างสมจรงิ หรอืเป็นภาพที่แสดงสี

ตามหมกึพมิพ์ ชนดิของไฟล์ภาพที่มกัน�ามาใช้

ใน Photoshop แบ่งตามประเภทได้ดงันี้

JPG, JPEG (Joint Photographic 
Export Group)
JPEG เป็นไฟล์ภาพที่ใช้งานมากที่สดุ ใช้ใน

งานรทีชัได้ด ีเพราะแสดงสไีด้สูงถงึ 16.7 ล้าน

ส ี ส่วนใหญ่เป็นภาพเสมอืนจรงิ เช่น ภาพววิ

ทวิทศัน์ ภาพคน หรอืภาพที่สามารถไล่โทนส ี

ที่สวยงาม 
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GIF (Graphics Interchange 
Format)
เป็นประเภทของไฟล์ที่เหมาะกับ

งานด้านเว็บไซต์ เนื่องจากลดทอนสี

ให้เหลือประมาณ 256 สีได้ ไฟล์ภาพ

จึงมีขนาดเล็กลง เหมาะกับงานที่ม ี

รายละเอยีดสไีม่มาก เช่น โลโก้ ที่ส�าคญั

ไฟล์ประเภทนี้ยงัแสดงภาพแบบพื้นหลงั

ทะล ุ(Transparency) และใช้บนัทกึภาพ

เคลื่อนไหวได้ด้วย ตัวอย่างของภาพแบบ GIF ท่ีสามารถบันทึกภาพแบบพื้นหลังทะลุ เพื่อน�าไปใช้ในงาน
สร้างเว็บไซต์

ตัวอย่างการออกแบบข้อความแล้วบันทึกไฟล์เป็น PNG ไปใช้ร่วมกับการสร้างเว็บไซต ์
สามารถบันทึกแบบพื้นหลังทะลุได้ แต่ก็ยังสามารถแสดงสีได้อย่างครบถ้วนสมบูรณ์

PNG (Portable Network 
Graphics)
PNG เป็นไฟล์ที่รวมคุณสมบัติของ 

GIF และ JPEG เข้าด้วยกนัคอื บบีอดั

ขนาดไฟล์ให้เล็กได้มากกว่า GIF ถึง 

30% แต่ยังแสดงสีได้เหมือนภาพแบบ  

JPEG นอกจากนี้ยังบันทึกภาพแบบ 

พื้นหลงัทะล ุ(Transparency) ได้โดยไม่มี

ปัญหาขอบหยกัเหมอืนไฟล์แบบ GIF

RAW 
เป็นไฟล์ภาพจากกล้องดจิติอลในกลุม่ DSLR ที่เกบ็รายละเอยีดของภาพได้สงูมาก การจดัการกบัภาพลกัษณะนี้จะ

ต้องใช้ Camera Raw มาช่วยในการท�างาน

ไฟล์ RAW เป็นไฟล์
แบบใหม่ที่นิยมกันใน

หมู่ตากล้อง เนื่องจาก
สามารถน�าไปตกแต่ง

ด้วยค�าสั่งมากมาย 
โดยที่ไม่ท�าให้ภาพ

เสียหาย
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ไฟล์แบบ PSD เป็นไฟล์แบบ 
Native คือ เปิดใช้งานด้วย 
Photoshop เท ่านั้น มัก
บันทึกภาพเป็นไฟล์นี้ เมื่อ
ต้องการแก้ไขในภายหลัง

ไฟล์แบบ TIFF เก็บรายละเอียดของภาพได้สูง แต่ก็จะมีขนาดไฟล์ที่
ใหญ่ ส่วนมากมักใช้กับงานพิมพ์คุณภาพสูง

TIFF (Tagged Image File Format)
เป็นไฟล์ที่สร้างใน Photoshop เพื่อน�าไปใช้กับงาน 

สิ่งพิมพ์ เนื่องจากสามารถเก็บรายละเอียดต่างๆ ของ

ภาพได้เป็นอย่างดี และไฟล์ประเภทนี้สามารถใช้ได้กับ

ทั้งเครื่อง PC และเครื่อง Macintosh  

PSD
เป็นไฟล์ที่ได้จากการท�างานใน Photoshop ไม่มกีารบบีอดัขนาดไฟล์ภาพ ท�าให้มขีนาดค่อนข้างใหญ่ แต่มขี้อดคีอื 

เปิดขึ้นมาแก้ไขได้ โดยที่โครงสร้างแบบ Layer จะคงอยู่เหมอืนเดมิ

ท�างานกับไฟล์ภาพใน Photoshop CC
การท�างานกบัไฟล์ภาพจะเริ่มจากค�าสั่งจดัการไฟล์เบื้องต้น เช่น เปิดไฟล์ หรอืบนัทกึไฟล์ ดงัรายละเอยีดในหวัข้อ

ต่อไปนี้

คลกิเมน ูFile>Open... หรอืกดปุม่ + O  
เพื่อเปิดหน้าต่าง Open ขึ้นมา

1

เปิดไฟล์ภาพมาใช้งาน
การเปิดไฟล์ท�าได้หลายวิธี ขึ้นอยู่กับความ

ถนัดของผู้ใช้และประเภทของไฟล์ วิธีการต่างๆ 

ท�าได้ดงันี้
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เลือกแสดงเฉพาะประเภทไฟล์ที่ต้องการเปิดใช้งาน 
หรือเลือก All Formats เพื่อแสดงไฟล์ทั้งหมด

คลิกเพิื่อเปิดภาพ 
ที่มีชื่อเรียงต่อกันทั้งหมด

หากต ้องการเป ิด

ภาพอย่างรวดเร็ว ให้

เปิดโฟลเดอร์ที่เก็บภาพ 

แล้วแดรกเมาส์น�าภาพ

มาวางใน Photoshop 

ภาพกจ็ะถูกเปิดทนัที

หากมภีาพเปิดอยู่แล้ว 

และต้องการเปิดภาพใหม่

เพิ่ม ให้แดรกเมาส์น�าภาพ

มาวางบรเิวณ Tab ชื่อภาพ 

หากวางในต�าแหน่งเดิม 

จะเป็นการซ้อนเลเยอร์

ภาพ

หากแดรกเมาส์น�าภาพมา
วางบนภาพที่เปิดไว้แล้ว จะ
กลายเป็นการน�าภาพมาใส่
ซ้อนลงไป  

เลือกภาพจากโฟลเดอร์ แล้ว 
แดรกเมาส์มาวางใน 

Photoshop

คลกิเลอืกไดรว์ หรอืโฟลเดอร์ที่เกบ็ภาพไว้ใช้งาน2

คลกิเลอืกภาพ3

คลกิป่มุ Open4
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เปิดภาพซ้อนกันด้วยค�าสั่ง Load Files into Stack

เลือกออปชนันี ้เมือ่ต้องการ
ให้ภาพในแต่ละเลเยอร์ซ้อน
กันพอดี

เลือกออปชันนี้ เมื่อต้องการให้ภาพ
แต่ละเลเยอร์เป็น Smart Object

ส�าหรบัการท�างานบางประเภทใน Photoshop เช่น การ

ท�า Stack Layers, การ Merge to HDR เป็นต้น จะต้องเปิด

ภาพทั้งหมดให้ซ้อนกนับนพาเนล Layers ด้วยค�าสั่ง Load 

Files into Stack ซึ่งค�าสั่งนี้จะซ้อนภาพและจดัเรยีงแต่ละ

ภาพให้ตรงกนัได้ดงัขั้นตอนต่อไปนี้

นอกจากการเปิดภาพด้วยวิธีที่ผ่านมาแล้ว เรายัง

สามารถเปิดภาพได้อย่างรวดเรว็ โดยให้ดบัเบลิคลกิ

บน Workspace เพื่อเปิดหน้าต่าง Open หลงัจากนั้น

เลอืกโฟลเดอร์และภาพที่ต้องการได้ทนัท ี(วธิกีารนี้ใช้

ไม่ได้หากท�างานกบั Workspace แบบ Start)

NOTE

ดบัเบลิคลกิทีว่่างบน Workspace เพือ่เปิดหน้าต่าง Open

ในกรณทีี่ต้องการเปิดไฟล์ RAW ด้วย Photoshop CC 

โดยไม่ผ่านค�าสั่ง Camera Raw กส็ามารถท�าได้โดย 

กดป่มุ  แล้วดบัเบลิคลกิไฟล์ RAW ที่ต้องการ 

เพยีงเท่านี้ภาพกจ็ะถูกเปิดขึ้นใน Photoshop ทนัที

NOTE

เมื่อหน้าต่าง Open ปรากฏข้ึน ให้กดปุ่ม  ค้างไว้
แล้วดับเบิลคลิกไฟล์ RAW ที่ต้องการ ภาพก็จะถูกเปิด
ขึ้นใน Photoshop CC โดยไม่ผ่านค�าสั่ง Camera Raw

คลกิเมนู File>Scripts>Load Files into Stack 
เพื่อเปิดค�าสั่งขึ้นมา

1

คลกิเลอืก Files 2

คลิกปุ่ม Browse... แล้วเลือกไฟล์ภาพที่
ต้องการ เมื่อเรยีบร้อยแล้วให้คลกิป่มุ OK

3

ภาพที่เลือกจะถูกเปิดขึ้นมา 
และซ้อนกนัพร้อมน�าไปใช้งาน

4
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ท�ำงำนกับไฟล์ภำพเบื้องต้น 03
CHAPTER

เปิดไฟล์ภาพแบบ Smart Object
Smart Object คอื การแปลงไฟล์ภาพปกตใิห้กลายเป็นวตัถทุี่ย่อ-ขยายได้ โดยไม่เสยีความละเอยีด สามารถเปิดไฟล์

ภาพปกต ิแล้วแปลงให้เป็น Smart Object ได้ด้วยวธิกีารต่อไปนี้

ดึงภาพจากกล้องดิจิตอลและสแกนเนอร์
เราสามารถดงึภาพถ่ายจากกล้องดจิติอลและสแกนเนอร์ผ่าน Photoshop ได้ด้วยการใช้ค�าสั่งพื้นฐานต่างๆ ดงันี้

ดึงภาพจากกล้องดิจิตอลผ่าน Photoshop
ใน Photoshop CC มคี�าสั่ง WIA Support เป็นค�าสั่งส�าหรบัดงึภาพจากอปุกรณ์ต่างๆ ที่เชื่อมต่อกบัคอมพวิเตอร์ มี

วธิใีช้งานดงันี้

คลกิเมนู File>Open as Smart Object...1 เลือกภาพที่ต้องการ 
แล้วคลกิป่มุ Open

2

ภาพถูกเปิดในรูปแบบ Smart Object สงัเกต
ได้จากสญัลกัษณ์บนพาเนล Layers

3

คลกิเมนู File>Import>WIA Support...1

2คลกิป่มุ Start เพื่อเริ่มต้นโหลดภาพ 3คลกิป่มุ OK


